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User Manual
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The Getting Started with FECFile User Manual was developed as a quick reference tool for Independent
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Getting Started

Electronic Filing

Electronic filing is:

1.

Required when an entity or other person receives contributions or makes expenditures in excess
of $50,000 in the current calendar year or has reason to expect to do so.

Voluntary for any entity or other person that receives contributions or makes expenditures less
than $50,000 in the current calendar year. However, once a filer decides to e-file on a voluntary
basis, it must continue to do so for the remainder of the calendar year, unless the Commission
determines that extraordinary and unforeseeable circumstances have made it impractical for the
filer to continue filing electronically.

Electronic filing passwords:

1.

In order to request a password, you will need a FEC ID. Because Independent Expenditure filers
do not register with the FEC by filing a Statement of Organization (FEC Form 1), you will not
receive your FEC ID until you have filed your first report. You can file your first report on paper
if you are below the $50,000 threshold for mandatory electronic filing or file electronically by
using the online Form 5 webform for a non-registered entity or person(s) without a FEC ID.
(Please note that once you use the webform, you are required to file all subsequent reports and
documents electronically).

Once you receive your FEC ID, you can obtain an electronic filing password by sending a
password request to the FEC Electronic Filing Office via mail, email
(efiletechsupport@fec.gov), or fax (202-219-0674). See the electronic filing password webpage
for password request letter requirements and a sample letter.

If you forget your password, you must request another one following the procedure above. For
assistance with passwords, please contact the FEC Electronic Filing Office (800-424-9530 Ext.
1307).

Downloading software:

In order to download FECFile, you will need an FEC ID. Because Independent Expenditure filers do
not register with the FEC by filing a Statement of Organization (FEC Form 1), you will not receive your
FEC ID until you have filed your first report. You can file your first report on paper if you are below
the $50,000 threshold for mandatory electronic filing or by using the online Form 5 webform for a non-
registered entity or person(s) without a FEC ID. (Please note that once you use the webform you are
required to file all subsequent reports and documents electronically).
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Note:

From www.FEC.gov, click the e-Filing link at the bottom of the page.

Links Inspector General

20463 [800) 424 9530 In Washington (202) &

AAAAAAAAAAAAAAA - Fh i miles e tkn IIIAL R

Click FECFile Filing Software.

Confirm Minimum System Requirements are met.

Click Download FECFile Now.

Click Download Now at the top of the screen for the most recent version of FECFile.

FECFile Update List

Download Now
Build X. X . X.X.

Enter the entity/filer's information and choose Submit. The committee 1D will begin with "C9."
Enter additional information (for new entities/filers only).

Click the FECFile X.X.X.X link to download FECFile.

Follow your computer’s download instructions.

Double-click the FECFile install icon and follow the installation prompts.

FECFile will automatically check for the latest program updates every time you start the
software.
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Using FECFile

This section will lead you through the step-by-step process for setting up your electronic filing database
(i.e., creating your “committee file” in FECFile), as well as creating your first Report of Independent
Expenditures Made and Contributions Received (Form 5). You will need to create the quarterly Form 5
report before creating a 24 or 48 hour report (Form 5).

Creating a New Committee File

Start FECFile using either the desktop icon or the computer’s Start Menu.

2. Click Create a new committee file. Use this file every time a report is created. You should only
create one committee file per Independent Expenditure entity.

3. A window will appear to confirm the creation of a new committee file. Click OK.

x

(% Create 5 new Comimittee File|

' Qpen an existing Committes Fle

4. Choose the appropriate Form 5 (F5) filer type, Individual or Organization (shown below), from
the following list and click OK. (If your committee type files on the Form 3X, please use the
Getting Started for PACs and Parties Guide instead of this guide.)

Select your Co il

F3P - Campaign Committes [Presidential]

F3 - Campaign Committee [Mon-Presidential]

F3 - Jaint Fundraising Committee [Authorized)

FZ+ - Joint Fundraizing Committee [Unauthorized)

FZ= - Political Action Committee

F3= - Political Party Organization

F 3 - Other [Political] Committes

F4 - Committees/Organization supporting convention

F5 - Independent Expenditure Filer - Individual [Mon-political /M on-profit

- Independent Expenditure Filer - Qrganization [Mon-political/Mon-profit]
F¥ - Communication costs Filer
F3 - Electionesring Communications Filer - [Maon-political /M on-profit] [ndividual
F3 - Elechionesning Communications Filer - [Maon-political/Mon-profit] Organization

1] | Cancel |

FECFile Training Manual
Page 4


http://www.fec.gov/support/GettingStartedManual_U.pdf

5. Click Yes at the prompt.

a. A system prompt will instruct you to enter the filer information. Select OK and enter the
FEC ID number (COXXXXXXX), name, and address. When finished, click OK.

E x|
I-"'"_"\'-I Would you like to create a Report and enter your Report
" Information now?
Yes Mo
Report informatic x|
Type of Feport I'
[
Drate From Drate Thu Election date
| =l =l =
Election cycle running in State
I - j I MHaone j

Creating the First Report (Form 5) in a New
Committee File

Independent expenditure filers are required to file
quarterly reports and 24/48 hour reports when

necessary. Filers will use the same process to create
each of these types of reports.

1.

2.

Once you have entered information about the
Independent Expenditure filer, FECFile will
prompt you to create your first quarterly report
of Independent Expenditures Made and
Contributions Received. Select the Type of
Report from the Report’s drop down menu.

To sign the report, click in the Signed by box.

Enter the name of the person completing the form

Signed by

[ Thiz report dizclozes a new committee address

Sianed by Far Sehedule E

OE.

Cancel

(last name, first name). If the individual has not already been entered into FECFile, press Tab or

Enter.

a. An “Individual/Organization” box will appear.

Ensure that the type selected is

“Individual other than a Candidate” and enter the rest of the person’s information (name,

address, etc.).

b. After entering the person's information, click OK to return to the Report Information box.

3. After all the information is entered, click OK.
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4. A window will appear, with options for what to do next in the report. To view the Summary

Page and begin to add transactions, click OK. For more information, you can move to the
section on “"Entering Contributions” on page 11 or the section on "Entering Independent
Expenditures” on page 12. To view the Individuals/Organizations screen, click Cancel. The
FECFile Basics section on "Working with Contributors and Vendors" on page 9 will provide you
information on entering contacts into your committee file.

x|

You may proceed to add fransactions to the current report QR
% you may choose to add Individuals/Organizations to your file.
Would you like to add transactions to the current report now?

K Cancel

Creating a New Report in an Existing Committee File

1.
2.
3.

In the “View” menu, click Reports.
In the “Edit” menu, click New, or right click anywhere in the Reports window and click New.

Select the report type you would like to create "Report of receipts and Disbursements (Form 5),"
"24 hour notice (Form 5)," "48 hour notice (Form 5)," or "Miscellaneous Electronic Submission
(Form 99)" and click OK. Do not use "Form 1" or "Form 1M." For information on entering 24
or 48 hour reports, please see page 14.

Select the re x|

R eport of Beceipte and Disbursements [Farm F5]
24 howr notice [Form 5]

48 hour notice [Form )

Faorm 1 [Statement of Organization]

Form 1M [Motification of Multicandidate Status]
Mizcelaneous Electronic Submizzion [Farm 93]

k. Cancel
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FECFile Basics

Saving in FECFile:

FECFile creates a database (with file extension .DCf), which holds the entirety of the entity’s reporting
history. This includes all reports, amendments, and contributors or vendors with whom the entity/filer
works.

1. Save the file as often as possible. This will decrease the chance of massive data loss. Be sure to
save the file in a location easily accessible and easily remembered. Additionally, it is also
recommended that you back up the file to an external source, such as a flash drive, external hard
drive, or CD.

File Edit Yiew Tools Window Help

2. For each new report, open the same file that you created for the entity/filer. Do not create a
new file each time you want to create a report. This will lead to problems with calendar
year-to-date amounts and aggregate amounts. The next time you open FECFile after creating
you entity's file, you will be able to select the option to Always open this file when | open
FECFile. Checking this box will ensure you open the same file for each report.

Using the Different Views:

FECFile is organized into six different views or windows: Individuals/Organizations and Events; All
Transactions; Reports; Summary Page — Form 5; Receipts; and Disbursements. Each of these views
displays a different aspect of reporting and is used to create and modify both reports and transactions.
There are three different ways to access a view:

1. When FECFile first opens, tabs will be displayed underneath the icon bar. Click on the tab to
access the desired view. Tabs can be rearranged by dragging them to another location on the tab

bar.

£ FECFile - DCAL
File Edit Wiew Tools Window Help
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a. In order to view two tabs side-by-side, right-click on a tab and select Open in a
Horizontal Tab or Open in New Vertical Group.

b. Tabs can be closed by clicking on the “X” in the upper right-hand corner of the tab.

c. New tabs can be opened or re-opened by using the “View” menu or clicking on the
appropriate icon (see below for a list of FECFile Views). To open all available tabs, click
on Window in the upper left-hand corner and select Open All.

2. Under the “View” menu, select the desired view:

= WIEN,T
@ All Transactions ra
#ine

File Edit | View Tools Window Help
q Individuals/Organizations and Events
Eleckion Cycles

[ #tine | T
5 Summary Page
7 Receipts

Disbursements

Loans, Debts and Obligations

Recyde hin
SOtk .. ZhelH-r:
Search. .. Ctrl+F

3. Click on the icon, located across the top of the screen, representing the view:

DNy Yoy

About Each FECFile View:

Reports View — This view lists all reports created in the committee file. Transactions on these
reports can be modified if the report is “open” (see page 18). Reports also can be amended
using this view by right-clicking on the report and selecting Amend.

Summary Page — Form 5 View — This view shows both itemized (.I) and unitemized (.U) totals
for this period (ThisP) and calendar year-to-date (CTD) for each line number. Transactions
may be entered on line numbers by double clicking a line.

Individuals/Organizations and Events View — This view lists all entities entered into the
database, including the information for the entity/filer making independent expenditures,
contributors, other political committees, businesses, etc. Modify an entity by double clicking on
it.

Receipts View — This view lists all receipts entered in the report currently selected in Reports
View. Modify a transaction by double clicking it, or right click an entry for a list of options

FECFile Training Manual
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such as creating a new transaction, deleting a transaction, adding memo text, etc.

Disbursements View — This view lists all independent expenditures entered in the report
currently selected in Reports View. Modify a transaction by double clicking it, or right click an
entry for a list of options such as creating a new transaction, deleting a transaction, adding
memo text, etc.

All Transactions View — This view lists all transactions entered in the committee file.
Transactions are sorted by line number and name.

Memo Text:

Memo text is used to provide additional information regarding reports and transactions. Memo text can
be added by highlighting the report or transaction, right-clicking, and choosing Memo Text... from the
available options.

Working with Contributors and Vendors:

FECFile creates a database for all entities (individuals, businesses, PACs, Political Party Organizations,
etc.) within the committee file. This saves the filer from repeatedly entering the contributor or vendor
information if it conducts multiple transactions with a particular entity.

There are two ways to create an entity:

1. When entering the first transaction associated with an entity, make sure the cursor is in the
“Name” field and press Tab or Enter. The “Individual/Organization Information” window
will appear.

2. Using the Individuals/Organizations view, right click anywhere in the workspace and click
New from the available options. The “Invididual/Organization Information” window will
appear.

Filling Out the Individual/Organization Information Box

1.

2.

Select the correct entity type from the drop down menu at the top of the window.
e Note: FECFile disables any field that is not required for a type of entity.
After entering the information, click OK.

Using the FEC “Lookup” Feature:

Click Lookup... to access the FEC’s database of federally registered candidates and political committees.
Use the feature to save time when entering information for a federal candidate or political committee.

1.
2.

In the “Individual/Organization Information” box, click Lookup...

The “FEC ID Lookup” window appears. Scroll through the list and click once on the entry to
highlight it. You can also type the name of the candidate or committee in the name field and
then select Lookup to navigate to that entry.

Copy all applicable information by clicking Copy All....

Unchecking boxes in the window that appears will exclude that information from copying to the
entity record. Click OK, and all of the checked information will be copied into the entity record.

FECFile Training Manual
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5. Click OK to return to the transaction screen.

FEC ID lookup x

Committee/Candidate Mame C ... | Committee... | Other ID | -
FRIEMDS OF GUY PARISI H MY CO0Z88498  H4Mv19032
FRIEMDS OF HAME SaWDERS H Al COOZAYES3  H2AL 07025
FRIEMDS OF HEIDI FOR COMGRESS H i, Wit CO0333145  HEwa08049

H

H

FRIENDS OF HENREY F'WwWOJTASZEK MY CO0380083  HEMY28102
FRIENDS OF HERMAN CLARK FOR COWNGRESS Ga  CO0257162  H2GADE032
FRIENDS OF HIGHER EDUCATION INC DC  CO0324467

FRIEMDS OF HILLARY

g T T T T T

M COD361378  HOMI4074

FRIENDS OF HOLLEMBECK, FOR CONGRESS H [l

FRIENDS OF HOUSEMAM FOR COMGRESS H IN IN CO0302445  HEINO4034
FRIENDS OF HOWWARD MILLS 5 MY MWy CO0357331  SaNv00156
FRIENDS OF HOWWELL HEFLIN COMMITTEE 5 AL AL CO0085351  S8aAL00050
FRIENDS OF HUNTER SMITH FOR CONGRESS H ca CO  CO0335786  HEBCOO1048
FRIENDS OF ISAKSON 5 GA CO0392340  S6GA00113

MY CO0265470
Ca  CODT41747
Ga CO0261358  HE2GAO157
P& CO0352260  HOPAD4204
CT  C00334332 S4CTOON46 -

FRIENDS OF ISRAEL

FRIENDS OF ISRAEL POLITICAL ACTION COMMITT...
FRIENDS OF JACK. KINGSTON H G,
FRIENDS OF JACK. MACHEE, H P2,
FRIENDS OF JACK. ORCHULLI 5 CT

Prew Mest k Eop_l,.l.-’-‘n.ll...j Copy 1D I Cancel

o
=
WIITeo - wWwIwwI I

00358895 / SONYDD188 X

Mame : v IFHIENDS OF HILL&RY

Addess 1: W |1?'I?KSTF|EET Wi SUITE 3094

Address 2 W I

City : W |WASHINGTDN

State: ¥ [0 Zp: I [2003

"Candidate information

Office: W[5 State : W INY Digtrict : IDD
kK. I Cancel |
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Entering Contributions

1. Click the “Summary Page” icon at the top of FECFile. In the “Summary Page” window, double

click on Line 6 to enter a contribution.

MH = &2

=7 4

4 88855

Individuals/Crganizations and Events - r Reports r All Transactiuns/V Summary Page - Form 5 xr Receil

| Description

ThisP.I ThisP.U CTD.I CTD.U

#Line

Contributions
7 Independent expenditures

2. Click on the name in the list scroll box
immediately beneath the name field if the
entity already exists in the filer’s FECFile
database. If the entity is not in the database,
press Tab or Enter to add the information.
Refer to page 9 for more information.

3. Enter date and amount.
4. Click OK.

Contribution x|

Hame

IDDE,Jane

Doe, Jane - ..

Date Armaumnt
|‘| A5/2014 dl 10,000 I InKind

Drezcription

Election Year of Election T temo
LCandidate/Campaign Committes

¥ &goregate

Lobbyist/R eqgistrant Bundler [T F2L bundie

LCategomy code

| =i

Check Ma. Account [dentifier

| |
0k EI Cancel

Mext entry. . |
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Entering Independent Expenditures

1. Go to the “Summary Page” view and double-click on Line 7.
File Edit View Tools Window Help

N Hi=E2 3 L]

Individuals/Crganizations and Events - r Reports r AIITransactinns/

#Line | Description | ThisP.I |
& Contributions
Independent expenditures

2. An Independent Expenditure box will x|
appear.
M ame

3. Select the payee’s name from the scroll |
box below the “Name” field. If the 3 My Committes -
entity is not in the database, press Tab Doe, Jane - ..
or Enter to add the information.

4. Complete the dissemination date, Dissemination Date Amount — ™| tdemo

amount, and description information. | =i W Agoregate
For an explanation of what constitutes

the dissemination date, see the Form 5

instructions on the FEC website. Description

5. Indicate whether the independent |
expenditure supported or opposed the Landidate  Suppot ¢ Oppose
candidate. If the candidate is already in |
the dropdown box, you can select that
person. Otherwise, hit Tab or Enter to
create  an  Individual/Organization EEren S
record for that candidate. You can then | -
enter the candidate information or use
the "FEC Look-up Feature." Please Election Year of Election
refer to page 9 for more information | =l
about the "FEC Look-up Feature." Office State District

6. Enter the category code, select the [- = |Nene [
election type, year of election, and the
candidate’s office sought, state and MNext entry...| oK. | Cancel |
district (if applicable). For more
information about the category code,
please see the Form 5 instructions on the
FEC website. When reporting independent expenditures made in connection with separate

FECFile Training Manual
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elections in more than one state, allocate the cost of the independent expenditure and create a
separate entry for each state and election.

7. Click OK.

FECFile Training Manual
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24 and 48 Hour Reports

Creating 24 and 48 Hour Reports

24 and 48 hour reports are separate filings from Form 5 quarterly reports. Both are required to be filed
when the independent expenditures exceed the thresholds described in the Form 5 instructions on the
FEC website.

1. To prepare to create a 24 and/or 48 hour report, first create the Form 5 quarterly report for the
calendar year quarter during which the independent expenditures were made. See page 6 for
instructions on "Creating a New Report in an Existing Committee File."

2. To create a 24 hour report, go to the “Reports” view, right click on the white background, and
click New. Click “24 hour notice (Form 5)” and click OK.

Select the report type il

Report of Receipts and Disbursements [Form F5
24 hour notice

48 hour niotice [Faorm 5]
Faorrn 1 [Statement of Organization)

Form 1k [Motification of Mulicandidate Status)
Mizcelaneous Electronic Submiszion [Form 33)

] I Cancel

3. To create a 48 hour report, go to the “Reports” view, right click on the white background, and
click New. Click “48 hour notice (Form 5)” and click OK.

Select the report type ll

Repart of Receiptz and Disbursements [Form FA]
24 hour notice [Form 5]
45 hour notice [Form 5 i

Faorm 1 [Statement of Organlestion]
Form 1 [Motification of Mulbicandidate Status)
Mizcellaneous Electronic Submizzion [Form 93]

k. I Cancel

FECFile Training Manual
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4. The "24 hour Report” or -8 hour x|

Report” box will appear; fill in the
election date, the state, and enter the

Election date State
filer’s information in the “Signed by” - —
box. All fields are required. If the IE_“’MDH || caiformia [
report includes independent Signed by
expenditures made in more than one Dee, Jane
state, please enter any one of the Doe. Jane -...
applicable states (this information is
currently required in FECFile, but will
not appear on the coverage page of your oK. Cancel
report). L

5. Click OK. Note that at this point the
24/48 hour report is not complete until
an independent expenditure is added to the report.

Adding Independent Expenditures to a 24 or 48 Hour Report
6. Select the “Reports” view and select the 24 or 48 hour report by clicking on it.

7. Select the “All Transactions” view and locate the independent expenditure(s) that needs to
appear on the 24 or 48 hour report. If you do not see the "All Transactions" tab open, select
"View" in the upper left-hand corner to open the tab. Independent expenditures that have been
entered will show up on Line 7 in alphabetical order.

- * —
] ! »| . 2 A . @ —
LY =1E"C e < &3
e
Individuals/COrganizations and Events - r Reports &  All Transactions x Summary Page - Form 5
I FLine | MName | Description

¥ Commerdal Makers, | Commerdal production costs

Mew, .. Inis

Modify... Cirl+m

Delete Del

| Addtod8hourReport.. |
Wl

Transackion SElit..

Loan/Debt payments, ..

Memo Text...

Redesignate /Reattribute. .. >

Eargive/Settle, ..

Glase Repork, .,
armnend) ..

Sort... Cirl+r
Itemization 3
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8. After finding a transaction, select the entry, right click, and click Add to 24 hour Report or Add
to 48 hour Report. The Independent Expenditure transaction box will open with the previously
entered information. Make sure the information for the transaction is correct and click OK to
add to the notice. Repeat this step until all of the required independent expenditures have been
added to the 24 or 48 hour report.

9. The 24 or 48 hour notice is now complete. Close and upload it in the same manner as a regular
Form 5 Quarterly Report (see page 17).

10. Please note, if an entity has filed a 24 or 48 hour report, it must also file a separate guarterly
report for that calendar year quarter (even if the independent expenditure information is
identical).

FECFile Training Manual
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Closing/Uploading/Amending

Closing a Report
1. Go to the “Reports” view.

2. Right click on the report and click Close Report.

ol
LN - _L} 3 :__ﬁ/} E
[ = ‘ o 2 J}‘ e
Individuals/Organizations and Events /V Reports x
Type | Opening Cash | Cl
April 15 Quarterly 0.00 a0,
July 15 Quarterly 0.00
43 hour Report Mew... Ins
Modify... Ctrl+m
Delete Del
Farm 2.,

Transackion Split...

Loan/Debt payments, ..

Memo Text. x
Redesignate Reattribute. .. 3

Eorgive/Sette, ., Date clozed

armend [g

Sork... Zhrl

Itemization g

Cancel |

3. Enter today’s date in the “Date closed” field and
click OK. (Note: a Filing ID is only required when filing amendments and should be left blank
for new reports.)

i ; = ‘ = - Ed  Es
Uploading a Report > M= & 2 5
K . A A Ind'rvidualstrganizationsandEvents-/V Reports =
1. First, follow the directions above for closing a report. Type |_Cpening Cash [
(Closed reports should appear in pink/purple in the e 2=t= .00
“Reports” view) Bhouteo =

2. IMPORTANT: Save the file before uploading!

FECFile Training Manual
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Click Upload from the “File” menu, or click the

Upload icon.

Enter the password (see page 2), 9-
digit FEC ID number, and email
address.  You must confirm the
password and email address by
entering them a second time or the
report will not upload.

Unless otherwise directed by the
FEC’s Electronic Filing Office or
an FEC analyst, leave TCP/IP as

File Edit View Tools Window Help

L8 =

Fall

x|
Upload | Configurel
 Filer information
MR (CO0255345 [e.g C12345678)
Fax | [e.0 202219067 4)

Confirm | [case-sensitive)

Pazsword I

Confirm | [e.g johndoe@cmte. com)

e-mail 1 I

Confirm | [2.g janedoed@cmte, com)

e-mail 2 I

— Filing Methad

* TCPAP € 550 ¢ Digwp & B © Other

the Filing Method and then click
OK. (Note: “This filing amends”
field should not be filled in for new
reports.)

[ File it o the best zerver [ will not be received by the agency |

Thiz filing amends I

Save the committee file after the
report uploads.

QK I Cancel Help

Amending a Report

Amend a report when changes need to be made to a report that has already been uploaded. If the report
has not yet been uploaded, right click on the report to unclose it and make the necessary modifications.

Creating an Amendment:

1.
2.
3.

Go to the “Reports” view.
Right click the report to be amended and then click Amend.
Click OK on the “Report Information” box and

click YES when prompted "Are you sure you want Fecnie =
tO mOdlfy the Selected Report’)" “?/-‘ Are wou sure you wank to madify the selected Report?
a. Note: reports originally filed on paper before = o |

the filer crossed the electronic filing threshold
cannot be amended electronically.

b. The report will now have an Al, A2, etc. in front of it. Al is for the first amendment, A2 is
for the second amendment, and so on

c. Note: these reports will automatically be generated, but not automatically uploaded. Also,
these additional amendments need not be uploaded unless there is a change in any of the
dollar figures (most commonly: calendar year-to-date or aggregate totals). If there are any
changes in the dollar figures for subsequent reports, please upload those reports as well.
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Modifying Transactions for the Amendment:

1. Locate the transaction you want to modify from the "Receipts,” "Disbursements,” or "All
Transactions" tab.

2. Double click on the transaction.
Make the desired changes to the transaction and click OK.
4. When prompted, click Yes to modify the selected transaction.

Adding New Transactions for the Amendment:

1. As with a new report, go to the “Summary Page” view and double click on the appropriate line
for that transaction.

2. Enter the transaction information and click OK.

Deleting Transactions from an Amended Report:

1. Locate the transaction you want to delete from the E
"Receipts,” "Disbursements,” or "All Transactions" 9 _
tab. - / Are you sure you want b0 delete the selected transaction?

2. Right click on the transaction and click Delete. ves ([ mo |

3. When prompted, click Yes to delete the selected
transaction.

Filing an Amended Report:

1. Anamended report is filed like a new report: Close the report, and then choose Upload from the
File menu.

2. If the original report was created using FECFile, the x|
software will automatically fill out the “Filing ID” field.

Date closed

1415406

Filing |0 [Original]
FEC-123456

a. Do not alter this number unless instructed by an
FEC analyst or the FEC’s Electronic Filing Office.

b. If instructed to alter the number, or if the number oK. I
does not appear in the box, the filing ID is located
on the FEC’s Candidate and Committee Viewer
website. Type in the committee’s ID number and
click Get Listing to find your committee’s electronic filings.

Cancel

http://www.fec.gov/finance/disclosure/efile search.shtml
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Secrets to FECFile

Common E-Filing Mistakes!

Passwords
e Remember to obtain an electronic filing password as soon as possible.

e Don’t wait until the last minute to apply for a password or to apply for a new one if necessary.

e Remember the entity/filer's password and keep it secure: the FEC cannot look up misplaced or
forgotten passwords; the report filer must request a new one.

Filing at the last minute

e Any problem, whether it’s technical or non-familiarity with the software, can be difficult to deal
with during the rush of a deadline week. It is advisable to always file as early as possible, especially
the first time the entity files electronically.

Email receipts confirm filing has been received

e After uploading the report electronically, a receipt will be sent to the email address or fax entered
when uploading the report. Assume that the report was not successfully filed if no receipt is
received. Call the Electronic Filing Office (800-424-9530 Ext. 1307) if more than a few minutes
pass without receiving a receipt.

e The receipt is proof of filing. Print it out and keep it.
Save and validate data set early and often

e Doing this through the process of report creation will ensure proper and consistent data entry as well
as prevent the loss of work due to unforeseen computer problems, i.e., freezes, crashes, etc.

Back up the data file!
e The file that contains all of the entity/filers reports, the “Data File” (*.dcf), should be backed up to
an external source.

e Itis very difficult and time consuming to recreate the committee file if it is lost.
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Common Validation Errors and How to Fix Them

Warning vs. Error Messages
There are two different types of validation errors: warning messages and error messages.
Warning messages:

These messages are a result of possible incorrect/missing information in the report. The user can choose
to correct the issues before uploading the report. However, these warnings do not prevent the filer from
uploading a report.

Error messages:

These messages result from more serious problems and prevent the user from uploading the report until
the errors are corrected.

Reading and Understanding a Validation Message

Each warning or error message contains basic information that allows the user to pinpoint which
transaction is causing the issue. It also gives a brief description of the error. For example:

Form{ltem}: F56 {Johnson}
Field Name: #011 Contributor Street 1
Warning is Required, but field is Empty

The Form {ltem} field identifies where the transaction causing the error is on the report. In the
example above, the transaction is on Form 5, Line 6 and is specifically identified as “Johnson.” Field
Name identifies the aspect of the transaction — in this case the street address field for the contributor —
that is causing the problem. The last line identifies what type of message this is (Warning) and
describes what caused the problem (is Required, but field is Empty).

In order to correct this problem, the user should find the specific transaction and edit it to disclose the
street address for the contributor with the last name Johnson.

The FEC’s website includes a more extensive list of commonly found warning and error messages along
with brief descriptions and solutions.

http://www.fec.gov/support/fag valid.shtml
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Common Error Messages

Below is a list of common error messages that committees encounter and the steps that need to be taken
in order to correct the errors. Please remember that all error messages must be corrected before you can
upload your report.

Filing must be in the current FEC format
e This indicates that you are using an outdated version of FECFile.

e FECFile users will need to download the latest version of the software from the FEC's website
(http://www.fec.qov/elecfil/updatelist.html).

Amended filing must have an ID of the **Original®

e This indicates that the user is trying to submit an amendment absent the original report 1D
number. The original report ID number must be used. If you are properly amending existing
reports in the committee file, the original filing ID should appear automatically.

e If the user cannot locate his receipt for the original report, the ID number can be located on the
filings tab of the FEC's Candidate and Committee Viewer website (see below)
(http://www.fec.gov/finance/disclosure/candcmte_info.shtml).

2016 &
Document Filed v m End Date 3 Page by Page = View / Download v
48 Hour Independent Expenditure Report New 05/25/2016 2 201605259017296284 PDF HTML/ FEC-1074552

e Once you have located the original filing ID (F5N), you will need to open, and then re-close your
report so you can enter the filing ID (see right).

e NOTE: If this original report ID number is entered incorrectly, system errors will occur on

upload.
x
Amended filing must have an ""Amendment Number"* Date closed Filing I [Original]

. . |1!1IZIHEIE FEC-191654

e This means that either the Fectile

amendment indicator is missing or

incorrect. The first amendment

will be Al, and each subsequent

amendment will be numbered in i | =
sequence.

1 E ¥ou have not uploaded the report that is being amended. Would vou like to continue?
L3

e This error most likely occurred
because you did not properly create an amendment or amended a report before it was filed.

e Don’t amend a report that you have not uploaded. FECFile will warn you with this message —
click Cancel.
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e, .., Ins

e In the “Reports” view, right click on the report you are trying et e
to file. If the report is closed, unclose it. Right click again Delete el
and click Unamend. Form &2,

Farmm 3E-1,.
Loan/Debt payments. .,
Mema Text...

e Repeat this process until your report is at the correct numbered Redesignate/Reatiribt. . b
amendment Forgive/Settle, .,
C ESE ;eiort. o
=] Chtlr
Ikemization »

Validation terminated! — Over 32,000 problems found!

e This indicates that 32,000+ errors have been found. The threshold for total errors for the system
is 32,000; therefore, the first 32,000 errors will be listed in accordance with their severity.

e |If you receive this message please contact your reports analyst or the FEC electronic filing
office.

ID# NOT correct FEC ID# format

e This indicates that the FEC ID number used
is not in the correct format.

Mame |

. . . Public Communications
e To correct this error, you will need to edit Exempt Political Action Committee - FILER

your FEC ID number. To do this, go to the Vaker Drive
“Individuals/ Organizations” view and locate ggz"'gzt,;ftwe Type

your filing entity. Double-click on your FedEx-Kinkos | Palitical Action Committee
i H H HERSETH, STEPHAMIE . _
entity name (it should be in red). Make sure ~ [Er=ci STEFHENE g C12345675)

Lookup... |

the FEC ID number is correct. It might help Johnisan, Jane
to use the FEC Lookup feature. YTy

e NOTE: (correct example: C91234567) - The
“C” must be capitalized.

{Field) is required, but field is empty
e This indicates that information is required to be entered in a particular field, but has not been.
e Locate the transaction and fill in the field.

Extraneous data follows last field
e This usually indicates a technical problem, generally involving invalid characters.
e You should call the Electronic Filing Office if you receive this error (800-424-9530 Ext. 1307).

e NOTE: Only characters between ASCII 22 and ASCII 126 are acceptable. The ASCII 32 - 126
used to be the only characters allowed; however, the foreign language alphabet and punctuation
characters are also allowed. Specifically, ASCII characters 32 - 168 are allowed (excluding 127
and the series 157 through 159). Also, 173 is allowed.
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Invalid double-quote surround text field — OR - Embedded double-quotes (**) not allowed
e This indicates that there are a set quotes around a text field where there should not be.
e Locate the transaction/field and take out the quotes.

e NOTE: Quotes are used as part of the data delimiter. Since the introduction of a level-8
message that says "Embedded double-quotes (") not allowed", this message only applies to the
very last field of a CSV string and only in the instance where a begin-quoted text is not
terminated with an end-quote. (Example: falling within the maximum length of that last field.)

e ADDITIONAL NOTE: Any field can have begin/end quotes (they are necessary for text that has
embedded commas). However, any field that has surrounding quotes may not also contain
double quotes anywhere within the text. Validator is only trapping “"embedded quotes™ within
"text fields" which have surrounding begin-quotes and end-quotes. For example [,""",] is a case
of an embedded double-quote, but [,",] is not.

Body of text exceeds maximum of 20,000 characters (F99 filings)
e F99 (Miscellaneous text document) filings are limited to 20,000 characters in length.
e To correct this, either shorten your Form 99 filing or file more than one.

Leading blanks {e.g. "* TEXT"'} not allowed
e This indicates that there are blanks prior to data; this is not allowed.

e Locate the transaction/field and delete the spaces that precede the first word in the file.

Bad date — not YYYYMMDD format
e This indicates the user has entered a date in the incorrect format.
e Locate the transaction and re-enter the date trying this format: MM/DD/YYYY.

is not a real date
e This indicates that the user has entered an invalid date.

e Locate the transaction and enter a valid date.

Invalid amount format: — OR = Non-numeric data in numeric field

e This indicates that the user has entered values other than m x|
numbers and decimals.

e Locate the transaction and enter only numbers and one decimal ! \  Please enter a number.
point. FECFile will issue a warning before this error is made.

(See right)

e NOTE: Dollar signs and commas are not permitted.
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is an invalid year (CCYY) format
e This indicates the user has entered the year in the incorrect format.

e Locate the transaction and make sure the year referenced in the date field is in a four-digit
format.

District """ is not 2-digit numeric format
e This indicates the user failed to enter the congressional district as two digits.

e Locate the transaction, and make sure the congressional district field has two digits (ex: 04, 11).
Using the FEC Lookup feature might make things easier.
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